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Installation and Release Notes for Applixware/Anyware 6.1 
May 6, 2009 

(Build# 141) 

 

Overview 
     

This document contains important information about the Applixware/Anyware 6.1 release 
for Solaris, Linux and Windows platforms. While some information is valid for all three 
platforms, specific information for Applixware/Anyware 6.1 on Solaris, 
Applixware/Anyware 6.1 on Linux, Applixware 6.1 on Windows, respectively, is clearly 
marked. Please read these release notes before installing Applixware/Anyware 6.1.  

 

These release notes are organized as follows: 

• Applixware/Anyware 6.1 Enhancements and Changes 
• Overview of Previous Applixware/Anyware 6.0 Enhancements and Changes  
• System Requirements and Platform Support 
• Before You Install 
• Installing Anyware 
• Known Issues 
 
NOTE: For information concerning licensing, please see the document 
"License_HowTo.txt" on the top level of the CD. It contains Applixware/Anyware 6.1 
licensing instructions for the various platforms. 
 

Applixware/Anyware 6.1 Enhancements and Changes 
 

New or updated features since the previous Applixware 6.0 (Build# 97) release: 

 

• Support of SFC API 4.5.1 L3  for RMDS Engine for Solaris, Linux  and Windows which 
fixes the following SFC issues: 

  

 Previously, RV Connection disconnected when DACS connection is down. In this 
release, RV connection will no longer be disconnected and the user can continue to 
subscribe data using the existing user profile until DACS connection is recovered. 
After that, the user's permission will be re-checked by SFC.  

 

 Furthermore, new configuration parameters, stopSubscriptionWhenDACSDowns 
and stopPublicationWhenDACSDowns, are provided to stop subscribing from or 
publishing any data to TIC/RTIC when DACS connection is down. The default value 
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for both new configurations is False, i.e. when DACS connection is down, 
applications are still able to subscribe or publish the data, which is the same 
behavior like previous version (4.4.4). Otherwise, changing the configuration to 
True, SFC will have the same behavior like previous versions (4.5, 4.4.5). (SR 1-
1503778370) (sfc1905)(7004323) 

 

 SFC publisher no longer crashes when it publishes an additional partial field for the 
second time using the indicateSync(), indicateResyncComplete() or 
indicateUpdateComplete() method. (SR#1-1623414144) (sfc1923)(7004731) 

 

• Added new Netfeed Realtime engine to allow the user to bring Marketfeed.com data 
into an Applixware Spreadsheet.  (7004662) 

 

• Added  User Interface for Netfeed Realtime Engine. (7004705) 
 

• Added New feature SS Export to HTML into the Spreadsheet.  (7003566) 
 

• Enhanced the Directory Displayer including combining the file -> open/import and file -
> save as/export into two menu picks - file -> open and file -> save as.  (7003306)  

• Applixware Spreadsheet file no longer crashes when trying to open file in Anyware due 
to column size limit being reached.  (7004807) 

 

• In Applixware Spreadsheets, the Microsoft Excel import filter now ignores macro 
buttons during the import process.  (7004787) 

 

• Inserting Excel Named Range into an Applixware Spreadsheet is now working as 
designed.  (7004785).  

 

• Anyware: The macro Anyware_Heartbeat_rate@ now works as documented. 
(7004513) 

 

• The macro filter_wp_to_html@ no longer creates new graphics file with each export. 
(7004506) 

 

• The multiselect_event in a list box is now being triggered properly in Anyware. 
(7004443) 

 

• The listbox method value@ always returns size of 1 for a list box in Anyware. 
(7004442) 

 

• An AccessControlException will no longer be seen when using Anyware with the SUN 
JVM. The exact error was:  

  
 java.security.AccessControlException: access denied (java.lang.RuntimePermission 

modi fyThread) 
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        at java.security.AccessControlContext.checkPermission(Unknown Source) 
        at java.security.AccessController.checkPermission(Unknown Source) 
        at java.lang.SecurityManager.checkPermission(Unknown Source) 
        at sun.applet.AppletSecurity.checkAccess(Unknown Source) 
        at java.lang.Thread.checkAccess(Unknown Source) 
        at java.lang.Thread.stop(Unknown Source) 
        at .... 
        This error was not seen when using Microsoft VM. (7004423) 
 

• The Delete key now does a delete forward instead of backward to be consistent with 
other applications. (7003852, 7003946) 

 

• License How-To for Applixware for Windows installations has been revised to avoid 
misunderstanding.  (7004520) 

 

• New utility called RTCONV has been added helping users to migrate from legacy 
Realtime Engines such as axtib and triarch to the RMDS Engine.  (7004166) 

 

• Applixware Spreadsheets crash no longer  occurs when copying a sheet containing 3-
Dimensional Ranges.  (7004695)  

 

• Fixed issue when adding fields to an existing record while using the RMDS Engine.  
(7004630) 

 

• Fixed issue with Applixware Spreadsheet Title bar not updating properly when using 
File -> Save as.  (7004644) 

 

• Added File -> Export as PDF menu option for Solaris and Linux. For Windows, free 
PDF converters are available allowing to print to PDF format from within Applixware.  
(7004562) 

 

• aagtwy no longer crashes due to bad information being passed from axgfxsvr. 
(7004525)  

 

• Export to Excel 5.0 no longer fails due to numerous blank cells in the Applixware 
Spreadsheet.  (7004722)  

 

• New XML import and export filters were added to Applixware Words and can be 
accessed via the menu options File -> Open and File -> Save as. (7004019) 

 

• On the windows platform, the dialog editor does no long hang when opening certain 
dialog files (.db).  (7004733) 

 

• shell_command@ no longer fails if temp directory uses spaces.  (7002730)  
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Previous Applixware/Anyware 6.0 Enhancements and Changes 
 

The following list provides an overview of new or updated features since the last 
Applixware 4.43 release. This list may be useful for customers upgrading from Applixware 
4.43 directly to Applixware 6.1: 

 

Note: Customer upgrading from Applixware 4.43 to Applixware 6.61 need new license 
codes. Please contact licensingandmaintenance@vistasource for new permanent license 
codes. Customers upgrading from Applixware 6.0 to Applixware 6.1 do not need new 
codes. 

 

• On the Windows platform, Euro Symbol now works with all fonts. (7003053) 
 

• In Windows XP, Copy/Paste from Applixware Words to Applixware Graphics is now 
functioning correctly. (7003109) 

 

• Support of SFC API 4.5.1.L3 for RMDS Engine for Solaris and Windows which fixes 
the following SFC issues: 
 

 - When publishing alphanumeric fields to RTIC and subsequently updating a 
shorter value, the subscriber displays an incorrect value. This issue has been 
fixed by Reuters. 

 

 - SFC cannot handle negative FID's from a downloaded Marketfeed data. 
Dictionary. This issue has been fixed by Reuters.(SR 1-1118285128) 
(sfc1853)(etmd0694) 

 

 - SFC cannot handle negative enumerated fields. This issue has been fixed by 
Reuters. (SR1-1473786074)(7003607) 

 

 - RTIC no longer distributes corrupted data when it receives qform data 
containing DATE and TIME fields from the RMDS engine. This RTIC issue is 
fixed in RTIC 11.1.2.E2. (7004113)  

 

- Fixed the problem that SFC subscriber has RV Connection disconnected when 
DACS connection is down (SR 1-1503778370) (sfc1905)(7004323) 

 

- RMDS price fields are now properly updating when using large digits.  
(7003798)  

 

• Fixed problem with date and time fields with RMDS engine. (7004003, 7004137) 
 

• Fixed problem with incorrect date when subscribing using RMDS SSL and have 
parameter rtDateTimeAsString:0 set in your rtconfig. (7004136) 
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• Added support for XK_Eurosign key. (7003851) 
 
• Dates are now inserted in the proper language format when using French and German 

installations. (7004174 )  
 

• The date format dd/mm/yy now displays properly in a spreadsheet cell. (7004173)  
 
• Fixed crash issue when printing a specific spreadsheet range. (7004037)  

 
• When saving documents in Microsoft Word in RTF format and then opening these files 

in Applixware, headers and footers will now render properly. This issue started to occur 
after the following security updates are installed for Microsoft Word: 
 Security Update for Word 2003 (KB917334) 
 Security Update for Word 2002 (KB917335) 
 (7004121)  

 
• Arrow keys in an editable table now work properly. (7004110) 
 
• Fixed crash in words when using select-right to select into and through a table. 

(7003829)  
 

• Fixed crashing issue when using 443 dialog in 6.0 which occurred due to bad font 
reference. (7004139)  
 

• The size of a record name in the RMDS Contribution Dialog has been increased to 100 
characters. (7003984) 

 
• RMDS User Interface now inserts correct formulas when ssRtTibCompatibility is being 

used. (7004206) 

• Chain dialog for RMDS TIB User Interface now utilizes rtconfig parameter called 
rmds_ChainSector to specify sector you wish to use for chaining. The default is ANY. 
Please see rtconfig file for details on this new parameter. (7004216) 

 
• Added Wide Character Support. (7002911) 

• Added user interface for RMDS SSL and RMDS TIB Engine. (7003300) 

• Add online help for RMDS SSL and RMDS TIB Engines. (7003301)  

• RMDS SFC libraries are now dynamic. (7003743)  

• Realtime Status window no longer shows "contribution accepted" when publishing 
RMDS SSL data. The information is now written to a log file, where it can be read if 
logging is turned on. (7003359) 
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• Added MS Ctrl-x, Ctrl-c, Ctrl-v key bindings for cut/copy/paste to current menubars. 
(7003278) 

• Added System Information Tool. (7002816)  

• Added Quickstarts for Applixware RMDS SSL and Applixware RMDS TIB engines. The 
PDF files can be found in the rtgate/rmds directory. After installation they will be located 
at the top level of the install directory. The Quickstart documentation now explains how 
to use a custom appendix_a, see section "Environment Settings". (7003269)(7003269, 
7003358) 

• Added autorecognition of PDF file format in Applixware Mail. (7003270)  

• Added preference to allow a paste after doing a row or column insert. (7003284, 
7003503) 

• Added rtconfig file parameter to control date and time field formats when subscribing 
and publishing. VistaSource plans for a future release to add additional parameter to 
allow the display of time fields in local or GMT time. (7003291,7003294) 

• AxW Mail 6.0 now supports comments that contain parentheses in the "From" header. 
(7001134)  

• Improved filtering capabilities by integrating Anyware 2.2 filters. (7002910)  

• Improved User Interface by updating icons on the main menu and application express 
lines. (7002918) (7003277) (7002919) 

• Upgraded to new Macrovision Libraries. (7003273)  

• Changed default gridline to solid in Spreadsheets. (7003302)  

• Fixed problem with opening file containing small numbers. (7003630) 

• The setting of *sslFactory.InsertServices is no longer required in the sfcapi.conf in order 
to Publish data using the RMDS SSL engine. (7003361) 

• SS_SAVE_AS@ is now saving with proper permissioning for non-native file types. 
(7003419)  

• Fixed licensing problem when starting up multiple realtime engines in a rapid manor. 
(7003420)  

• Anyware 6.0: CTRL selection now working for Table widget in Builder application. 
(7003478, 7003563)  
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System Requirements and Platform Support for Applixware 6.1 
 

The following requirements may vary depending on the specific hardware platform and 
model, the size and number of documents open at the same time, and/or the volume of 
real time or RDBMS data in use.  
 

Memory 
 

 

Servers 
Solaris/Linux - 32 Mb minimum BASE configuration (64 Mb suggested) for OS and OS 
services, +20 Mb free/available real memory for FIRST concurrent user and +6 Mb for 
EACH additional concurrent user 
 

 

X Terminals 
4+ Mb for monochrome X terminals 
8+ Mb for color X terminals 
 

 

Workstations 
20 Mb free/available real memory 

 
 

Swap space  
An additional 15 Mb per Applixware user over the standard configuration is recommended. 

 
 

Disk space 
Approximately 175 Mb is required to accommodate Applixware (Words, Graphics, 
Spreadsheets, Data, Mail, Builder, and Filter Packs). Refer to your installation screen for 
the minimum disk space requirements. The set of online documentation requires 
approximately 60 Mb. Installation of the online documentation is optional. 
 

Windows 2000/XP/Vista 
 

The Applixware Windows 2000/XP/Vista installation provides for three installation types: 
Custom - Choose the components you wish to install. Total space required is 250 Mb 
(English). 
 

Typical - Base, Help, Online books, and clip art. Total space required is approximate 215 
Mb (English). 
 

Compact - Base software only. Total space required is approximately 75 Mb (English). 
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Optional Feature Space Requirements  
 

International dictionaries - Additional 20 Mb 

bdf fonts - Additional 8 Mb 

pcf fonts - Additional 4 Mb 

Hypertext help (Windows only) - Additional 36 Mb 

Online books - Additional 65 Mb 

ClipArt - Additional 36 Mb (maximum) 

Total - Additional 169 Mb   

 

Printers 
 

PostScript® and PCL5 printers. 4 Mb or more are recommended for PCL5 printers. PCL5 
color printers are supported; however, do not toggle on color for a PCL5 printer that does 
not support color. The resulting printed document may be incorrect.  
 

WinGDI format is also supported on Windows 2000/XP.  
 

 

Display devices  
 

For Solaris/Linux: 
 

Requires a minimum of 256 colors; Applixware uses the default visual of all X servers.  
 

For Windows 2000/XP/Vista: 
 

Requires a minimum of 256 colors and a minimum screen resolution of 800 x600 dpi.  

 
 
Platform Support 
 

Sun Solaris 2.6, 7, 8, 9, 10 
Linux - Red Hat 7x, 8, 9, Enterprise and Suse 8.x, 9.3, 10 
Windows 2000, XP, Vista 
 

VistaSource recommends that you install the latest patches or Service packs for your 
respective platform. Contact your system or operating system vendor for the appropriate 
operating system updates. 
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Database Gateways  
 

All gateways are believed to be compatible with earlier versions of database servers. 
Applixware SQL Gateways are available for the database clients listed below:  
 

Solaris: 
Oracle Pro*C/C++ 8.0.5.0.0 
Informix Client SDK 2.20.UC1 ESQL/C 9.20.UC1 
Sybase Open Client/C 11.1.1 
ODBC 
 

Linux:  
ODBC 
Oracle Pro*C/C++ 9.2.0.1.0 
Informix Client SDK 2.10.UC1 ESQL/C 9.16.U 
 

Windows 2000/XP: 
ODBC 
 

 

The actual database servers tested are listed below: 

Operating System: Sun Solaris 2.6 
Oracle: Server Enterprise Edition 8.0.5.0.0 
 

Operating System: Sun Solaris 8, 9 
Oracle: Server Enterprise Edition 9.2.0.1.0 
Sybase: SQL Server 11.1.1 
Informix: Dynamic Server 7.30.UC7 
 

ODBC Drivers for Applixware Data 

 

Solaris: 
Sybase 10.0.2 
Informix 5.1 
Oracle 7.1 
Microsoft SQL Server 
 

Linux: 
Usually the database drivers are provided by the Database vendors. Please contact your 
database vendor for the available drivers. 
 

Windows 2000/XP/Vista: 
Usually the database drivers are provided by the Database vendors. Please contact your 
database vendor for the available drivers. 
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Applixware RealTime Engines 
 

This product was compiled with the following Data Provider Libraries: 

Triarch: Reuters Triarch 3.01.F61 (Solaris, Windows) 
 

TIBCO Rendezvous: Reuters TIBCO Rendezvous RV 6.6.5 and TIB 9.4.5 SR 4.0.1 
(Solaris, Windows) 

 

Bloomberg: Bloomberg V 1.9 (Solaris, Windows) 
 

RMDS: Reuters SFC C++ API 4.5 .1 L3 (Solaris, Windows) and SFC C++ 4.4.5 E1 (Linux) 
 

TIBCO ci Server: TIB API 9.2.11 (Solaris) 
 

 

Anyware 6.1 
 

The Anyware Server is not supported on Windows platforms (Windows 2000, XP). 
Windows 2000 and XP can be used as the Client machine when running the Anyware 
Server on Solaris or Linux.  
 

The product was tested on the following browsers: MS Internet Explorer 6.0, Windows 
2000 and XP using MS JVM Release 5.0.03810 and Sun Java 1.4.1/1.4.2, JRE 1.4.1_02. 
 

Netscape Browsers are currently unsupported on any platform, because of performance 
issues. 
 

The apache module product was tested using Apache Webserver 1.3.x.  
 
NOTE: Apache Webserver 2.0 does not properly work for this release (7001628) 
 

 

The following issues exist for Anyware 6.1: 
 

In Anyware 6.x Spreadsheet, if you use the Reuters Triarch RealTime engine only the 
default service DSS is listed. As a work around you can create a shell script called sstat 
that returns the expected sstat output. If you choose this option you need to backup the 
original sstat executable and replace it with your shell script, e.g. like this sample script: 
#!/bin/sh  
echo "IDN_SELECTFEED,R,U"  
echo "DDS,R,U"  
echo "CPS, P, U"  
echo "IPS,P,U" 
 (7002934) 
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In Anyware 6.x for setting up the realtime functionality, you need to set the environment 
variables in the .aaenv file in user's home directory. Different engines need different 
variables:  
RMDS SSL - MASTER_FID_FILE, ENUM_FILE  
axtibrv/RMDS TIB - cfile_path, LD_LIBRARY_PATH and PATH .  
Please NOTE: When setting LD_LIBRARY_PATH you will also need to include the 
<install_dir/axdata/axshlib explicitly. For example:  
LD_LIBRARY_PATH=/opt/vistasource/axdata/axshlib:/usr/tibco/tibrv/lib 
 

In Anyware 6.x the Realtime menu options will not appear in the Spreadsheet menubar by 
default. You can use the following workaround: If you choose to install any of the realtime 
engines, a file called syslogin.am will appear in the install_dir/axlocal directory. Make a 
copy of this file calling it aasyslogin.am. Edit aasyslogin.am and change the line 'macro 
syslogin' to 'macro aasyslogin'. (7002933) 
 

In Anyware 6.x the accelerator keys will not work after a menu option is clicked. (7002864) 
 

In Anyware 6.x when using Anyware Graphics with SUN JVM, the accelerator keys will not 
work if the main graphics area is not in focus on the screen. (7003001) 
 

 

Before You Install 
 

The following list describes important issues that you should be aware of before you install 
Applixware 6.1, especially if you have a version of Applixware prior to Applixware 6.0 
installed:  
 

All users who are upgrading from a version of Applixware prior to Applixware 6.0 will need 
to obtain new licenses. When you install on a new machine, you will be issued a 30 day 
license. Please contact VistaSource for your permanent license. 
 

Since Applixware 6.0, the default menu bars jave changed. If you wish to use your 
Applixware 4.x custom menu bars in Applixware 6.x, you will need to merge your custom 
menu bars with the 6.x menu bars. Applixware 6.x provides a macro called mbmerge@ to 
facilitate this process. See the on-line help for more information. To re-create any options 
you changed in your Applixware 4.x menu bar, you can also choose * -> Customize Menu 
Bar in the appropriate application, and re-apply your edits. Refer to the Getting Started 
manual for additional information. 
 

NOTE: The mbmerge@ macro will produce unpredictable results if you are attempting 
to merge two customized menu bars with the new 6.x menu bar. It is intended to 
merge: 
 

1. your customized menu bar  
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2. the default menu bar for that version of Applixware 
3. the new 6.x menu bar  
 

NOTE: Applixware 6.x features a new set of icons in the main menu and all menu 
bars. These icons are used by default. If you prefer to use the legacy icons, please set 
axIcons44x to 1 in the ax_prof4 file to toggle between the new and old icons. 
 

 

If you use Applixware in evaluation mode and use Applixware Mail, and then do not 
license Applixware Mail, you should turn off automatic import of mail and the mail notifiers. 
Otherwise, Applixware Mail automatically imports your mail messages and you cannot 
retrieve them. (78907) 

 

The Font Installer is not supported for Applixware 6.x on Linux. (7002418)  
 

Installing Applixware 6.1 on Solaris: 
 

To install the product on Solaris: 

1.  Insert the Applixware 6.1 CD into your CD-ROM drive. 
2.  CDrom should automount. 
3.  Type in an xterminal/shell window: 

cd /cdrom/cdrom0/setup/applix 
4.  Then type: 

./install 
 

If automount does not work, follow these steps: 

1.  su root 
2.  Kill the Volume Management Daemon (vold)  

 

To return pid of vold, type:  

%ps -edf |grep vold 

            %kill <pid> 

3.  Mount your CD-Rom drive. Use the following syntax: 
 

mount -F hsfs /dev/sr0 /cdrom/cdrom0 

4.  cd /cdrom/cdrom0/setup/applix 
5.  ./install 
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Installing Applixware 6.1 on Linux: 
 

To install the product on Linux: 

1.  Insert the Applixware 6.1 CD into your CD-ROM drive. 
CDrom should automount. 

2.  Type in an xterminal/shell window: 
cd /mnt/cdrom/setup/applix 

3.  Then type: 
./install 

 

If automount does not work, follow these steps: 

1.  su root 
2.  Mount your CD-Rom drive. Use the following syntax: 
 

mount /dev/cdrom /mnt/cdrom 

3.  cd /mnt/cdrom/setup/applix 
4.  ./install 

 
 

Installing Anyware 6.1 on Linux: 
 

An additional script is needed to install Anyware on Linux. After installing Applixware as 
described above, follow these steps: 

1.  cd /mnt/cdrom 
2.  ./anyware_install  

  

Installing Applixware 6.1 on Windows 2000 and XP: 
 

To install the product on Windows 2000 and Windows XP: 

1.  Insert the Applixware 6.1 CD into your CD-ROM drive. 
2.  Auto-run will start the installation program. 

 

If Auto-run does not start on your PC, then: 

1.  Choose Start -> Run from the Windows taskbar. The Run dialog box appears. 
2.  Type D:\SETUP.EXE in the Open entry field, where D represents the letter 

designation of your CD-ROM drive. 
3.  Click Open. 

 

Follow the on-screen prompts and instructions to complete the installation. 
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Known Issues and Usage Tips  
 

Unless specifically marked, these issues are valid on Applixware 6.x on Solaris, Linux and 
Windows platforms: 

 

Slower performance has been reported when Applixware (a non-multi-threaded 
application) runs on a multi-process machines. We recommended to force Applixware 
(axmain.exe) to use only one CPU for optimal performance. The following steps may be 
taken to set axmain.exe to use one CPU: 
 

1. Started Applixware and then launch the Windows Task Manager (press 
CTRL+ALT+DEL, or right click the clock display on the Windows Taskbar and select Task 
Manager) 
2. Select the *process* tab 
3. Locate and right-click on the axmain.exe process 
4. Select the *set affinity* option from the popup menu 
5. Uncheck all but one CPU and click OK. 
 

To set axmain.exe to use only 1 CPU permanently you can do the following: 
 

1. Download the imagecfg.exe tool from the Web or install it from the Windows 
XP Server Resource Kit. 
2.Unzip the tool and copy the file to C:windowssystem32. 
3.After creating a backup copy of your axmain.exe executable on a different location on 
your hard drive, open a command prompt and go to your axdata folder 
4.Type: * imagecfg -a 0xn axmain.exe* 
Replace *n* with the CPU you want the process to use. 
1 = CPU0 
2 = CPU1 
4 = CPU2 
8 = CPU3 
5. Close the command prompt window. 
Applixware is now "patched" to run on the virtual CPU N only when started.  

(7004797) 

 

 

By default, Applixware adds a .xl5 extension to Spreadsheets files saved in Excel 5.0 
format.   To change this default setting, you can edit axdata/eng/filters.sp (or frn/filters.frn 
or grm/filters.grm); find the following line:  
SS:XLS 5.0:filter_ss_to_xls5@:108:xl5 
and change it to:  
SS:XLS 5.0:filter_ss_to_xls5@:108:xls  
(7004321) 
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Published field disappears if it is not re-published during RMDS Engine startup or restart. 
Reuters has indicated that this is a limitation of the SFC API. If a SASS3 publisher sends 
out only an update (without the full image), RTIC won’t remove the existing fields. 
However, SFC cannot send updates without an image. As a work around, if a SFC SASS3 
publisher sends a record template number along with an image, RTIC will not remove the 
cached fields which are not the new published image. This workaround requires more 
configuration overhead. (SR 1-2705751469)(7004649) 
 

 

License keys are case senstive in Applixware 6.x. For example, if the key supplied to you 
was:  
FEATURE *wgm vistasrc 4.0 permanent 1 SIGN=5A0554208B24 
but the following is entered in the axlicensedat file:  
FEATURE *wgm vistasrc 4.0 permanent 1 SIGN=5a0554208b24 
then at startup of the license server you may see the following error:  
14:28:43 (vistasrc) Invalid license key (inconsistent authentication code)  
To fix the problem, please ensure the license key is identical to the supplied license key. 
(7004439) 
 

 

The Macrovision Flexlm license manager requires an eth0 on your Linux machine in order 
to generage the license Mac Address. If you don't have an eth0 configured on your 
machine then axhostid will produce improper results and Licensing will fail. Unfortunately, 
there is no work around to this limitation of the Flexlm Software. (7004672).  
 

 

Courier fonts may not render properly by default when converting RTF files to Postscript 
format. To fix the problem you can make an edit your fontmap.dir file. Basically in the file 
we removed the PostscriptAlternateline for the Courier New font definition. The 
fontmap.dir file is located in /install_dir/axdata/fontmetrics. You should backup the original 
file and then put the attached file in its place. (7004632) 
 

 

In order for Copy and Paste macros to work properly when using the Graphics Server 
(axgfxsvr) to run a macro from the command line, you may need to execute some 
additional steps. For Copy & Paste to work properly with the Graphics Server, system 
fonts need to be loading properly into the axgfxsvr. Similarly, starting Applixware you can 
pass a '-fp' option to the Graphics Server. 
Initially, you may have started the axgfxsvr as follows: 
$APPLIXWARE/axgfxsvr -file /tmp/axgfxsvr.log & 
You will need to issue the following new command: 
$APPLIXWARE/axgfxsvr -fp 
$APPLIXWARE/axfonts/all_pcf,/usr/openwin/lib/X11/fonts/misc -file 
/tmp/axgfxsvr.log & 
(7004528) 
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For Applixware 6.x some OS patches are required on Solaris for RMDS to  
function properly:  
- Solaris 2.6  105591-20  
- Solaris 2.7 106327-23 (32-bit), 106300-24 (64-bit)  
- Solaris 8  108434-17  
- Solaris 9 111711-15 (32-bit), 111712-15 (64-bit)  
 
To install these patches, please follow these steps:  
1. Installing patch for OS Solaris by using "patchadd"  
- Solaris 2.6  105591-20  
- Solaris 2.7 106327-23 (32-bit), 106300-24 (64-bit)  
- Solaris 8  108434-17  
- Solaris 9 111711-15 (32-bit), 111712-15 (64-bit)  
 
2. After adding the patch, new library shall be installed in path  
"/usr/lib".  
- libCrun.so.1 and  
- libCstd.so.1  
3.  Make new link named "libCrun.so" and "libCstd.so" and  
point to "libCrun.so.1" and "libCstd.so.1" respectively.  
$ ln -s libCrun.so.1 libCrun.so  
$ ln -s libCstd.so.1 libCstd.so  

NOTE: No patch is required for Solaris 10. (7003658) (7004317) 

 
For Windows only -  Using active scrolling while a calculation takes place can cause 
problems in the spreadsheet. You can turn off active scrolling to prevent any problems by 
adding the following preference to your ax_prof4 file: ssWinNoActiveScroll:-1   (7004926)  
 

 

For Windows only - The following error may occur when starting Applixware 6.x if a 
previous version of Applixware was installed on the same system: 

An internal Applixware error has been detected  
Save any work in progress immediately  
Bad return from DeleteObject(), The operation completed successfully. 

A workaround exists by navigating to C:/windows and removing the shelf.dll file if it exists. 
(7004403) 
 

 
For Windows only - The default, platform independent setting for the Euro symbol is ^!4 
(Ctrl-Shift-4) for all languages. (7003052) 
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In Windows 2000/XP only - In Applixware Graphics, actions like cut/paste, group/ungroup 
involving bitmapped images increase memory usage, but do not show memory being 
freed. (4448249)  
 

 

For Windows only - Dialog boxes larger than screen size are not supported with 
Applixware. (7004933)  
 
 

For Windows only - Position problems may occur when using Euro in Applixware 
Graphics.(7004338)  
 
 

For Windows only - If Helvetica font is installed on your system prior to installing 
Applixware, you may see some display issues when using Help and Builder. (7004006)  
 

 

For Windows only - When using the insert -> special characters menupick it is 
recommended to use Windows System Fonts to ensure consistent results. (7004008) 
 

 

When starting up the license deamon on Linux, if you don't have the directory structure 
/usr/tmp, the start up of the license daemon will fail. The Macrovision software requires 
/usr/tmp to create a lock file for the license daemon. To work around this issue you will 
need to create /usr/tmp with proper write permissions. (7004118) 
 

 

In Anyware 6.x you can access two types of help: Applixware native help (e.g. Help-
>Topic) and HTML help (e.g. Help->On Anyware->General Information). The HTML help 
does not work if you are using a POPUP blocker. You must disable the POPUP blocker if 
you would like to use Anyware HTML help. (7003571) 
 

 

When using Applixware on RedHat 4.0 (RHEL4), please note that SFC 4.4.5 is not 
supported by Red Hat 4.0. The Applixware Realtime RMDS engines will not work as a 
result.  
 

 

When writing an Applixware Custom RealTime Engine, users who are interested in 
specifying a certain type for a particular field, can use a new function: RtGetFieldType. 
The function looks like this by default: 
int 
RtGetFieldType(char *field_id, char *record, char *service) 
{ 
  return -1; 
} 
At the moment, the types that can be specified are: 
TYP_INTEGER 
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TYP_FLOAT 
TYP_STR 
TYP_DATE 
TYP_TIME 
These types are located in rtlibapi.h, which is part of the toolkit. Most users will simply use 
the default function as above. (7003664) 
 

 

If you are using Applixware Builder and ELF applications and experience unexpected 
flickering, especially when using colors in the tab widget, please check if backing store is 
enabled for your X Server. To do so, run 'xdpyinfo'. If backing store is not enabled, the 
'screen' section of your output may show: "options: backing-store NO, save-unders NO". 
In this case, you need to add the '+bs' flag to the command being used to start your X 
Server.  
If you are using gdm (the GNOME Display Manager), the relevant configuration file is 
/etc/X11/gdm/gdm.conf. The "command=" line is located under "[server-standard]". Add 
the +bs switch, e.g. command=/usr/X11R6/bin/X +bs.  
If you are using kdm (the KDE display manager), first search the file /etc/kde/kdm/kdmrc 
for a line beginning "Xservers=". Normally, this line will point to a file such as 
/usr/share/config/kdm/Xservers, which usually resolves to /etc/X11/xdm/Xservers. This file 
will normally contain a single, non-comment line that looks something like this:  
 :0 local /usr/X11R6/bin/X  
Change the line to be:  
:0 local /usr/X11R6/bin/X +bs  
If you are using xdm you should search for the file /etc/X11/xdm/Xservers. This file will 
normally contain a single, non-comment line that looks something like this: :0 local 
/usr/X11R6/bin/X  
Change the line to be:  
 :0 local /usr/X11R6/bin/X +bs  
NOTE: In all cases a reboot will be required for the new settings to be activated. 
(7003699) 
 

 

When migrating from our Triarch SSL engine to the RMDS SSL engine, you may 
experience an initial performance decrease when publishing large amounts of data per 
minute (30-40,000 updates per minute). This change in performance may be alleviated 
with the SFC configuration parameter numOutputBuffers. This parameter would be set in 
the sfcapi.conf. Sample setting would be: `*numOutputBuffers:10000'. In addition, if you 
are using the DTS there is a parameter called "MAX_NUMBER_OF_READ" which 
controls the number of consecutive SSL reads it performs on the source side before 
reading on the sink side. Increasing this value above the default of 30 may help. If you 
need about 30-40,000 updates per minute then setting the parameter to 240 should be 
sufficient. If your MDS is managed and/or administered by Reuters, please speak to your 
Reuters Account Manager to get assistance with this modification. (7002981) 
 

 



Release Notes for Applixware 6.1   Page 19 

We have provided a preference ssRtTibCompatibility to help with migration from our axtib 
engine to our RMDS engines for TIB. This preference allows you to keep using the 4-
argument syntax of the RTS function as the axtib engine requires. For example when 
using the axtib engine a sample formula would be: =RTS("rt", "axtib", 
"RSF.REC.AMZN.O", "BID"). To obtain the same result with the default RMDS engine the 
syntax would be: =RTS("rt", "vsRMDS", "RSF" "RSF.REC.AMZN.O", "BID"). To use the 4-
argument RTS syntax you will need to add to your ax_prof4 file `ssRtTibCompatibility:-1'. 
This new preference requires that you are using 4-part subjects for RMDS. This is not the 
default setting. To use 4-part subjects you will need to edit your rtconfig file and verify the 
following is set: `rmds_UseFourPartSubjects:1' (7003120) 
 

 

When using the Applixware RealTime RMDS engines, Historical Data is not available. 
VistaSource plans in the future to re-introduce this functionality to its RMDS engines. 
(7003620) 
 

 

Starting the License Daemon on Applixware 6.x on Linux Red Hat Enterprise causes the 
following build error.due to third party libraries being used: "Incorrectly built binary which 
accesses errno or h_errno.d directly. Needs to be fixed.'' This error can be ignored and will 
not affect the performance of the License Daemon on Linux Red Hat Enterprise. The error 
does not occur on Red Hat 8 or 9 or Suse. (7002554) 
 

 

For Solaris and Linux only - In Applixware 6.x in order to type the Euro symbol by default 
you currently need to use the key sequence Ctrl-Shift-$ in English and German, and Ctrl-
Shift-4 in French. These key sequences are controlled by the preference 
axEuroDollarCurrencyAccel which is set in the file axdata/<lang>/ax_prof4.<lang>.There 
is a second preference called axEuroDollarCurrencyKeySeq, if you prefer any other key 
sequence besides the control, shift or alt key. You obtain the key sequence by running 
ax_echo in the axdata directory. For example, on a French PC keyboard you may want to 
use Alt Gr - E for the Euro Symbol: 
1) run ax_echo 
2) type Alt Gr, then E - you will see output for the Euro key such as: 
LookupString returns: Key is XK_EuroSign, 
keycode 26 (0x1a), keysym=ox20ac (8364), 
state=144 (0x90) ( Mod2 Mod5), keystring=<>, string in hex= 
IsKeypadKey = FALSE 
IsFunctionKey = FALSE 
IsCursorKey = FALSE 
XLookupKeysym returns: NULL 
Based on the information regarding keycode and state, you can set the preference as 
follows: 
axEuroDollarCurrencyKeySeq: 26,144  
Please note that these numbers will differ depending on OS. (7002421) 
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In Applixware 6.x Linux when choosing Query->Tables, elforacl throws the error 
AxSqlError ORA-01019 unable to allocate memory in the user side. To avoid this error, 
you need to create $ORACLE_HOME/oracore/zoneinfo/timezone.dat. This is an oracle file 
that will exist on your oracle server machine, axnet.cnf can point to the location of this file. 
If you are uncertain of the location of your timezone.dat, we have provided two files in the 
axdata directory called ora_timezone.dat and ora_timezlrg.dat which can be referred to in 
the axnet.cnf file. (7002022) 
 

 

For Applixware 6.x on Solaris and Linux, the following environmental settings for the 
location of appendix_a and enumtype.def files for the RMDSSSL engine may need to be 
set depending on the setup of the user system. Normally, both appendix_a and 
enumtype.def are kept in user /var/triarch dir. In this case the user should set the following 
before starting Applixware: 
setenv MASTER_FID_FILE /var/triarch/appendix_a 
setenv ENUM_FILE /var/triarch/enumtype.def  
MASTER_FID_FILE variable points to appendix_a and ENUM_FILE variable points to 
enumtype.def. (5013508) 
 

 

RMDS will fail if you have V3.0 in ipcroute file. If IPCROUTE file looks like: 
triarch_sinkV3.0.sinklib:machine_name:realtime, you need to delete V3.0. (5013512) 
 

 

License Manager will not autostart when Applixware is launched. Alternatively, you can 
create a boot script to start the License Manager manually at boot time. (5013432) 
 

 

The preference axMemoryLimit only works when set to the default value. A new 
environment variable AX_MEMORY_LIMIT (which works like the preference) can be used 
if the user needs to change the default value. This variable AX_MEMORY_LIMIT may 
need to be used with a second Applixware environment variable, 
AX_MEM_CHUNK_SIZE, for proper memory allocation depending on your memory 
needs. Internally, Applixware allocates memory in chunks (blocks) that have a maximum 
size of AX_MEM_CHUNK_SIZE (the default is 131072), and the maximum number of 
chunks is fixed at 2048. Therefore, to find the optimal chunk size that will allow Applixware 
to allocate up to the requested memory limit, divide the memory limit by 2048. For 
instance, if a user sets AX_MEMORY_LIMIT to 2047 intending to allocate 2047000000 
bytes, they need to set AX_MEM_CHUNK_SIZE to 999511 (2047000000 / 2048). 
Otherwise, the software will only allocate up to the maximum number of chunks multiplied 
by the default chunk size (2047 * 131072=268304384).Note that AX_MEM_CHUNK_SIZE 
must be a power of two, and Applixware will round up the given value to the nearest 
power of two. (5013498) 
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Applixware crashes with signal 11 when querying an invalid file in Load Corba Objects 
dbox. (4450719) 
 

 

Applixware Spreadsheets miscalculates discrete floating point values. If you change the 
cell style to `Fixed', the majority of extended decimal point values will show correct values. 
(4449576) 
 

 

Charts created in 4.2 and opened in 4.4.X may have some extra white space and scale to 
fit issues. (4448707) 
 

 

POP3: If you are using Applixware as your POP3 server and as a POP3 client, the client 
server connection will hang if you have an unread message in your Inbox which has a line 
ending with ... (4444514) 
 

 

When running with File Locking on, the number of file descriptors in Real Time shows 1 
more than correct value. (4447568) 
 

 

Euro symbols will not be mapped properly in Oracle 8 without a patch, which is available 
directly from Oracle. You must use the NLS_LANG database environment variable to map 
8-bit characters for both elforacl and elfodbc. It is in the form, 
NLS_LANG=language_territory.charset. This variable can be set in the axnet.cnf file as 
follows: 

setenvFor elforacl NLS_LANG=.WE8ISO8859P1 
setenvFor elfodbc NLS_LANG=.WE8ISO8859P1 

To use this environment variable, you must have Oracle 8 client software installed. 
 

 

The YEARABS function may not display properly in Applixware Spreadsheets. Make 
certain that the numeric style of the cell containing the function is set to something other 
than date. (4456012) 
 

 

When working with large Applixware Presents presentations (with approximately 80 or 
more slides) and trying to sort them in 100% zoom mode, you can only view the first 23 
slides. (4457280) 
 

 

The program axhostid incorrectly displays the current date and time instead of the date 
and time the license daemon was started. (4457243) 
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When using the Long data type for BLOBs in an Oracle 8 table, only data previously 
saved in Applixware format, ASCII text, or HTML text can be inserted into a row or edited. 
(4456656) 
 

 

When using the Long raw data type for BLOBs in an Oracle 8 table, Data will not accept 
Applixware-formatted files, ASCII files, or HTML files into the BLOB. (4456660) 
 

 

In Oracle 8 tables that have either the Long or Long raw data type, you cannot save a 
BLOB to an external file (outside the database) in edit mode. (4456662) 
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Filters 
 

The following lists document limitations and known issues with the Applixware 6.x filters. 

Limitations with MS Word 2000/XP Filters in Applixware 6.x  
 

Unknown objects that are lost, like MS Project objects and VISIO drawing objects, appear 
as Unhandled OLE Object (or the actual object type). 

Bar tabs lose bar. Applixware converts bar tabs into left tabs. 

Font character attribute Animation is not supported. 

Vertical rules are not supported between columns. 

Merged cells that span rows are not supported. 

Page borders are not supported. 

Character styles are not supported in Applixware. 

Emboss and Engrave character settings convert to light gray in Applixware. 

Shading fills less than 10% may display white. Shading fills at 80% or higher may display 
black on 8-bit color monitors. 

Sequential numbered series fields can be labeled Equation, Table and Figure. Custom 
labels may show as default numbered series. 

Highlighting is not supported. 

When exporting a presentation to another graphics format, regardless of which slide/page 
you are on, only the first slide is exported. (4449491) 

 

Limitations with MS Excel 4.0, 5.0, 7.0, and 97/2000/XP Filters 
 

Applixware imports only worksheets from MS Excel 3.0 and 4.0. To import workbooks: 

Save each worksheet to a separate file and import each separately - 

OR 

Open a workbook in MS Excel 5.0, save it as an MS Excel 5.0 file and import it into 
Applixware 4.0.  

Spreadsheets cannot import embedded objects other than charts. Note that in 4.42 
pictures of embedded objects are imported. 
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External references will be imported as Labels preceded by the string "Problem in 
Formula...". 

Applixware handles invalid range names as follows: 

If the range name is less than three characters or if the first three characters are not 
alphabetic, three leading underscores will be added to the range name. For example a1 
will be renamed to ___A1. 

Invalid characters in the Range name will be replaced with the letter 'q'. For example 
A1&name will be renamed to A1qname. 

Applixware does not retain any name or label in MS Excel that refers to an expression. 
The expression will be substituted for each name or label. An error message will appear 
reporting the type of problem and how the import filter handled it. 

Special characters used in MS Excel will be imported unless two different fonts exist within 
the same cell. 

Colors/borders/patterns (shading) are imported as closely as possible, however there is 
no one-to-one mapping. Please notify us if you notice imported colors, borders or patterns 
that could have been matched better. 

Importing Date Formats is supported, but there is no one-to-one mapping. Please notify us 
if you observe date formats which are not imported correctly. 

NOTES (comments) associated with cells in MS Excel are not imported. See bug 81869. 
We export Applixware strings that exceed 256 characters into MS Excel's Notes (or 
"Comments" in MS Excel 97/2000). 

Headers and Footers are imported and exported. In 4.41 Applixware imports only the 
active worksheet's headers and footers, prior versions imported the first worksheet's 
header and footers. 

Title Rows and Cols are imported (only those that are adjacent and only as many as 10). 

There are two types of MS Excel titles: 

Title panes (set under Window Freeze pane) that are only displayed. (titles.xl5) 

Print titles (set under Page Setup - Sheet) that are printed on each sheet by MS Excel. 
(titles2.xl5) 

Applixware imports MS Excel's title panes which both display and print in Applixware. 
Applixware ignores MS Excels print titles. 

MS Excel Macros and Visual Basic procedures are ignored. 

Charts are not exported, they are ignored. 

Pivot tables are not supported in Applixware. The last saved data in MS Excel pivot tables 
is imported. 

Hidden cells are not supported. MS Excel hides the cell formulas but displays the cell 
results (enabled after protecting the sheet). Applixware hides both the cell formula and 
result for entire rows and/or columns. (Lotus hides the cell result but displays the cell 
formula). Applixware imports MS Excel hidden cells as normal cells and ignores the 
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hidden attribute. Applixware has invisible cells which show the contents if you select them. 
Applixware spreadsheets lose this attribute when exported to MS Excel. 

Password-protected sheets can be imported, however the sheet's password is ignored. 
MS Excel's locked cells change to Applixware protected cells. 

Password-protected files cannot be imported. Attempting to import password-protected 
files brings up the following alert: "This file is protected and encrypted. Cannot read." 
Resave your file without password protection and reimport it. 

Arrays are not supported as arguments within formulas (array formulas ARE supported). 
In 4.3.7 and 4.4 these are imported with the following format: { Array Formula 
(unimportable) }. They are NOT detected by our interactive process (Unsupported 
Functions and Import Problems dialogs). Instead you may see "Trouble with cell: A:B3" at 
the end of your Spreadsheet for each occurrence. (4446972) 

Character formatting is not supported in Applixware. The format of the initial cell contents 
is applied to the entire cell. 

Hyperlinks are not supported. Applixware loses the hyperlink but maintains the actual text 
and (usual) blue styling. 

Per sheet formatting is not supported. Applixware formats all sheets based on the active 
sheet (last sheet viewed when saved). 

Links are supported when importing MS Excel files by converting the actual linked material 
to a graphic object and embedding the picture in the Applixware Spreadsheet. Links are 
not exported, they are ignored. In 6.x Applixware will output a comment in the MS Excel 
file for all Applixware objects. 

Adjust to: in MS Excel's Page Setup is not supported in Applixware. Typically one could 
adjust their *.xls file to print on one page which when imported to Applixware can not be 
supported. Instead use MS Excel's Fit to: field which is supported and can preserve 
printing your Spreadsheets on the specified number of pages. 

View Zoom settings are converted from the active MS Excel sheet in Applixware 6.x, 
except in rare cases when zoom is less than 20% in MS Excel. These convert to a 20% 
zoom. 

Each of Applixware's ten database functions Dxxx has a corresponding function XDxxx 
which calculates in the same manner as the functions in MS Excel. Importing the MS 
Excel database functions converts them to the corresponding Applixware XDxxx functions. 
Exporting XDxxx functions converts them to the corresponding MS Excel database 
functions. Applixware Dxxx database functions are not supported in MS Excel and instead 
of exporting a function, a message indicating this will be exported. To ensure compatibility 
when exporting from Applixware to MS Excel use the XDxxx functions. 

Notes and Comments in MS Excel 97/2000 are ignored by our imports. (81869). 

When exporting to MS Excel 97/2000/XP file format, use the 5.0 MS Excel files. The 
features available in 5.0 are not different from later versions. MS Excel 7.0 and 97/2000 
are both capable of opening 5.0 files. 



Release Notes for Applixware 6.1   Page 26 

Double byte characters (Unicode) that have the high eight bits set do not map into the 
standard 256 character set (MS Excel 97/2000 adds an extended range of characters, 
Unicode, for international support) and therefore can not be converted to Applixware's ISO 
Latin-1 set (or others based on 256 characters). In version 4.4, Applixware substitutes a 
question mark (?) for Unicode characters with the high bits set. If you see question marks 
in your imported files, you should resave the MS Excel 97/2000 files in formats (5.0 or 7.0 
(95)) that do not support Unicode. 

Applixware Spreadsheets: the function MDURATION exports to XLS 5.0 as YIELDMAT. 
(4448139) 

Exporting an Applixware Spreadsheet to MS Excel 5.0 when using the ODDLPRICE and 
ODDFYIELD functions may cause errors when opening file in MS Excel. As a workaround 
you can use the MS Excel 4.0 export filter. (4448011) 

 

 


